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1. What is a spreadsheet program? How does it differ from a word processing   program?

A spreadsheet program is mainly used to perform calculations. It has features which allow data input, retrieval and organization of data to be made effortlessly. Spreadsheet programs have made bookkeeping much easier. 

It differs from word processing in that it is mainly used to work with numbers for instance, perform calculations, solve equations, etc. and word processing programs are mainly used to write letters, essays, etc. Word processing programs cannot solve equations or perform calculations and so on. Another difference is that spreadsheet programs are laid out in rows of columns. It consists of cells (intersections of rows and columns) where data is typed into.
2. What is the difference between a worksheet and a workbook?

A worksheet is a single spreadsheet in a workbook where one can work on (enter data, etc.). A workbook consists of multiple worksheets represented by Tabs at the bottom of the Excel screen. Hence, worksheets are analogous to the pages in a book.

3. How do you copy and move cell contents?


To copy cell contents firstly, highlight the cell contents to be copied. Right-click on it, a cascade menu will appear, select “copy”. Alternatively, you can click on the “copy” icon in the standard toolbar. Next, you can either right-click on the area where you would like the cell contents to be and select “paste” from the cascading menu or you can just click on the area and select the “paste” icon from the standard toolbar.

To move cell contents, the same procedures are used in copying cell contents except select “cut” instead of “copy” from the cascading menu and select the “cut” icon instead of the “copy” icon from the standard toolbar. 

4. How do you use the fill handle to copy contents of cells and to create a sequence? What type of sequences can be created using the fill handle?

To copy contents of the cell by using the fill handle, simply click on the cell content to be copied. Move the cursor to the small black box located at the bottom right corner of the cell, a plus sign will appear. Then click and drag on the area to be filled with the data.


To create a sequence, you must first type in at least two data of a sequence in separate cells. Highlight the sequence that you’ve type in, move the cursor to the small black square at the bottom right corner of the cell, a plus sign will appear. Afterwards, click and drag to the area to be filled with the matching data. The sequence from the data you entered will appear automatically.

The type of sequences that can be created using the fill handle are: consecutive numbers, number patterns, days of a week, months, years, dates, etc.
5. How do you create custom headers and footers? 

Click the worksheet in which the header and footer is to be created. On the View menu, click Header and Footer. A dialogue box will pop up. Click on “Custom Header” or “Custom Footer”. Click in the Left section, Center section, or Right section box, and then click the buttons to insert the header or footer information you want in that section. You can enter additional text for the header or footer, by typing it in the Left section, Center section, or Right section box.   
6. What is a relative cell address reference? How do you change a relative reference to an absolute reference? What is a mixed cell address reference?

Relative cell address references are the default in Excel. Relative cell address reference is when you type a formula in a cell, the cell address in which the formula refers to automatically adjusts if you copy the formula to new cells. 

To change a relative reference to an absolute reference, simply place a $ sign before the part that is not to be changed. For example, “A1” means relative column and relative row. To make the column and row absolute, type “$A$1”.


A mixed cell address is a cell address in which either the column or row is absolute but not both. For example, A$1 (relative column, absolute row).
7. What is the formula bar? What is the name box?


The formula bar is a bar at the top of the Excel window that you use to enter or edit values or formulas in cells or charts. It displays the constant value or formula stored in the active cell.

The name box is a box located at the left end of the formula bar which displays the selected cell, item, chart or drawing object. The name box is used to name a cell or range.

8. What is the difference between erasing the contents of a column and deleting the column?


The difference is when for example, you have 3 columns filled with data. If you delete the contents of the second column, two columns filled with data will remain but there will be a column space between them. However, if you delete the second column, two data-filled columns will remain but this time with no space in between them; the two columns will be adjacent with one another.
9. How will you freeze a part of the worksheet?


Select the area that you want to freeze, if it’s:

The top horizontal pane, select the row below where you want the split to appear. 

The left vertical pane, select the column to the right of where you want the split to appear.

Both the upper and left panes, click the cell below and to the right of where you want the split to appear.

After you have selected the area that you want to freeze, on the Window menu, click “Freeze Panes”.

10. What is the maximum number of significant digits possible in MS Excel?


The maximum number of significant digits possible in MS Excel is 15 digits.

11. What is the difference between a bar chart and a histogram?


A histogram is a chart (usually a simple column chart) that takes a collection of measurements and plots the number of measurements (called the frequency) that fall within each of several intervals (called bins).


A bar chart illustrates comparisons among individual items. Bar charts have the following chart sub-types:
· Clustered Bar  - This type of chart compares values across categories.
· Stacked Bar  -  This type of chart show the relationship of individual items to the whole.

· 100 % Stacked Bar   This type of chart compares the percentage each value contributes to a total across categories.
12. How will you put the error bars in the x-y plot? Make a table with data points along with their error values, and draw a graph with errors bars shown.  (hint: See Help facility in Excel)

Click the data series to which you want to add error bars. On the Format menu, click Selected Data Series. On the X Error Bars tab or the Y Error Bars tab, select the options you want.

(Please refer to the Excel workbook to view the graph.)

13. How will you protect a workbook in MS Excel?

Select Tools from the menu bar, select protection and click on “Protect Workbook”. Then select the “Structure” check box if you want to protect the structure of the workbook so that the workbook can't be moved, deleted, hidden, unhidden, or renamed, and new worksheets can't be inserted. Select the “Windows” check box if you want the window to be the same size and position each time the workbook is opened. The password is optional. However, if there is no password it would be easy for any user to unprotect the workbook. In order to prevent this type a password, click OK, and then retype the password to confirm it.
14. How to protect only selected cells in MS Excel?


If a worksheet is protected, the cells in the worksheet are automatically locked. To allow users to change some cell contents, select the cells and go to “Cells” from the Format menu and select the Locked check box (check box will be blank). Then protect the worksheet. By doing this, only some cells are protected.
15. Explain the different forms of log functions available in MS Excel.

LOG10(number) - Returns the base-10 logarithm of a number.
LOG(number,base) - Returns the logarithm of a number to the base you specify.

GAMMALN - Returns the natural logarithm of the gamma function, Γ(x).
LN - Returns the natural logarithm of a number. Natural logarithms are based on the constant e (2.71828182845904).
IMLOG2 - Returns the base-2 logarithm of a complex number in x + yi or x + yj text format.
EXP - Returns e raised to the power of number. The constant e equals 2.71828182845904, the base of the natural logarithm.

IMLN - Returns the natural logarithm of a complex number in x + yi or x + yj text format.
IMLOG10 - Returns the common logarithm (base 10) of a complex number in x + yi or x + yj text format.

LOGINV - Returns the inverse of the lognormal cumulative distribution function of x, where ln(x) is normally distributed with parameters mean and standard_dev. If p = LOGNORMDIST(x,...) then LOGINV(p,...) = x.

LOGEST - In regression analysis, calculates an exponential curve that fits your data and returns an array of values that describes the curve. Because this function returns an array of values, it must be entered as an array formula.

The equation for the curve is:

y = b*m^x or

y = (b*(m1^x1)*(m2^x2)*_) (if there are multiple x-values)

where the dependent y-value is a function of the independent x-values. The m-values are bases corresponding to each exponent x-value, and b is a constant value. Note that y, x, and m can be vectors. The array that LOGEST returns is {mn,mn-1,...,m1,b}.
16. In MS Excel, the argument of the sin functions should be in radians.  Assume that you are provided with a set of angles in degrees.  Use radians function in MS Excel to express the angles in radians and then find out the sin of these functions.
	Angles in Degrees (°)
	Angle In Radians (θ)
	Sine values

	360
	6.283185307
	-2.4503E-16

	180
	3.141592654
	1.22515E-16

	90
	1.570796327
	1

	60
	1.047197551
	0.866025404

	45
	0.785398163
	0.707106781

	30
	0.523598776
	0.5

	20
	0.34906585
	0.342020143

	78
	1.361356817
	0.978147601


17. Use of Help facilities in Excel:  Go through the Help facilities in Excel and study several different types of functions.  Explain the application of three different uncommon functions using your own examples.
AREAS - Returns the number of areas in a reference. An area is a range of contiguous cells or a single cell.
Syntax - AREAS(reference)
Example, =AREAS((A2:D5,E10,H1:J15)) The result will be “3”. Thus, there are 3 areas in this range.

REPLACE - replaces part of a text string, based on the number of characters you specify, with a different text string.
Syntax - REPLACE(old_text,start_num,num_chars,new_text) where:

Old_text - is text in which you want to replace some characters.

Start_num - is the position of the character in old_text that you want to replace with new_text.

Num_chars - is the number of characters in old_text that you want REPLACE to replace with new_text.

New_text - is the text that will replace characters in old_text.

Example, the data “1234bcd” is typed into cell B4. In another cell =REPLACE(B4,3,4,”@”) is typed. Four characters starting with the third character will be replaced by “@” which gives “12@d”.
TYPE - Returns the type of value. Use TYPE when the behavior of another function depends on the type of value in a particular cell.

Syntax - TYPE(value)

	If value is
	TYPE returns

	Number
	1

	Text
	2

	Logical value
	4

	Error value
	16

	Array 
	64


TYPE is most useful when you are using functions that can accept different types of data, such as argument and input. Use TYPE to find out what type of data is returned by a function or formula.

Example, “12ju3&*” is typed in cell C3. =TYPE(C3) is typed in another cell, this function will return the number 2 since the data type in cell C3 is text.
18. Calculation using Formulas: Select any formula (as complicated as possible) from any one of your textbooks. Use Excel to calculate this formula, by entering the constants and the variables separately. 
(Please refer to Excel Workbook)
19. Multiplot: Write down any one formula with two constants (a and b) and one variable (x). (eg. y=a sin(bx) or y=a x + b log (x) …etc).  You can also make up your own formula.  Use Excel to calculate your chosen formula for a range of x values at five different sets of constant values and tabulate them as x vs y with x in the first column and y in the next four columns as follows:

	No.
	x
	y values calculated using different set of constants

	
	
	a= …. b=…
	a= …. b=…
	a= …. b=…
	a= …. b=…

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


Plot all the four curves in the same plot and label them differently.  Comment on the effect of the constants on these plots. (Please refer to Excel Workbook.)
20. Solving Simultaneous Equations: Write a set of five equations with five variables (eq. p, q, r, s, t and u) and solve them using Excel.  Verify your answer by back substitution.

The set of five equations are:




q + w + y + z = 19,000




q + w + x + y = 19,200




w + x + y + z = 20,000




q + x + y + z = 20,500




q + w + x + z = 21,300
By using Solver in Excel, the values of the five variables were found to be:

	q=
	5000

	w=
	4500

	x=
	6000

	y=
	3700

	z=
	5800


Values obtained have been verified using the back substitution method:

	Equations used
	Solution

	q+w+y+z=19000
	19000

	q+x+y+z=20500
	20500


21. Solver exercise: The following data set is obtained in an experiment:

	R
	V

	0.5
	127.0355

	1.0
	48.0715

	1.5
	12.1348

	2.0
	8.3139

	2.1
	5.3366

	2.2
	3.1064

	2.3
	1.5361

	2.4
	0.5472

	2.5
	0.0689

	2.6
	0.0374

	2.7
	0.3957

	2.8
	1.0921

	2.9
	2.0807

	3.0
	3.3199

	3.1
	4.7728

	3.2
	10.0998

	3.5
	20.7786

	4.0
	31.9924

	4.5
	42.6319

	5.0
	52.1824

	5.5
	60.4667

	6.0
	67.4911


Use the solver module in Excel to fit the data using the equation 

V=a(1-exp(-b(R-c)))2,

where a, b and c are constants to be determined.  Use solver to determine these constants.  Calculate the V values using the values of a, b and c that you had found out by excel.  Plot the experimental and the calculated data in the same plot and label them properly.  What is the value of V at R=1.25 and R=c?


It is found that V= 30.08942362 at R=1.25 and V=0 at R=c. (Please refer to the Excel workbook.)

22. Solve Van der Waal's equation: (P + a/V2)(V - b)=RT, for the volume per mole (V) of an organic compound at 10 atm pressure and 400oK. The Van der Waals's constants for this particular compound are a = 40.0 liter2 atm/mole2 and b = 0.2 liter/mole. (Hint: use Goal Seek) 

V  was found to be 1.5 litres. (Please refer to MS Excel Workbook).

23. Select any equation such as given in the above question, from any of your text books and solve it using goal seek.

Equation:
f = 1/2l √F/(m/l)
where


f (Hz) = fundamental frequency


l (m) = length


F (N) = force


m (kg) = mass


(Please refer to Excel Workbook)

24. Grades distribution: Consider a class consisting of 12 to 20 students.  Create their mark list in their final exam.   The list should contain their names and their marks in two columns. Use the nested “if condition” to determine their grades (eg. A, B ….) and list them in the third column.  Present their grade distribution as a histogram and as a pie chart.


(Please refer to the Excel Workbook.)

25. Computerization of the laboratory report:  Present any of your experimental laboratory report involving detailed calculations and graphs, as an Excel workbook.  Your report should be self-contained and contain all the details to verify your graphs and results.  In short it should look as lab report that you would submit after completing your experiment.


(Please refer to the Excel Workbook.)

26. Exercises done in the computer lab: Present a complete report of all the excel exercises done during the lab hours. 


(Please refer to the Excel Workbook.)
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